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INTRODUCTION 

 
 

Digital literacy has been widely recognised as one of the key challenges to economic and 

social development for both individuals and nations in the 21
st

 century. Though India is 

home to more than 6,00,000 villages and 2,50,000 Gram Panchayats, the spread of digital 

literacy is almost non-existent. Some of the villages are too isolated to benefit from the 

country’s economic progress as they experience multiple challenges when it comes to 

access to Information and Communication Technology (ICT). However, there is a growing 

desire among people in rural India to be part of the country’s modernization process and be 

mainstreamed in the ever-growing digital revolution. 
 
 

To mainstream the rural community in the ever-growing digital society, the Basic Computer 

Course (BCC) has been designed with the objective of providing hands-on training in 

computers to the rural people, enabling them to acquire basic ICT skills that empower them 

to become digitally literate, actively participate in knowledge based activities, access 

financial, social and government services, and use Internet for communications. 
 
 

The BCC can equip a person to use computers in day-to-day life for professional and 
personal use to be able to: 
 

 Acquire confidence in using computer techniques;


 Recognise the basic components of computers and its various terminology;


 Understand data, information and file management;


 Create documents using Word processor, Spreadsheet & Presentation Software;


 Understand computer networks, Internet;


 Browse the internet, content search, email and collaborate with peers;


 Use e-Governance applications;


 Use computer to improve existing skills and learn new skills.
 
 

This BCC Handbook enables its readers to understand the basics of computers and learn 

about its various components and features. The exercises provided in between the modules 

enable you to get a hands-on training of the topics learnt in the module. 



1. KNOWING COMPUTER 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

LEARNING OUTCOMES 
 

By the end of this module, you should be able to: 
 

 Explain what a computer is
 Identify the hardware and software of a computer
 Set up and start a Computer

 

LESSON PLAN 
 

1.1 Basics of a Computer 
 

1.2 Concept of Hardware and Software 
 

1.3 Setting up and Working of a Computer 



1.1 BASICS OF A COMPUTER 

 

What is a Computer? 
 

A computer is an electronic device used to store and process data and information. It is a 

collection of two components - Hardware and Software. Hardware consists of the computer 

itself and any equipment connected to it and Software is the set of instruction that the 

computer follows in performing a task. 
 
 

Through a computer you can connect with your family and friends living miles away, store 
information, book railway tickets, access your bank accounts, etc. 
 

 

Classification of Computer 

Following are the different types of computer: 
 

1. Supercomputers  
2. Mainframe computers  
3. Microcomputers  
4. Notebook and Laptop  
5. Personal Digital Assistant  
6. Tablets 

 

Super Computers 
 

They are the largest and the fastest computers and hence are very expensive. They are 

capable of processing trillions of instructions per second. Param is the first and only 

supercomputer in India so far. These computers are mainly used in National Defence 

Agency, government agencies and also for weather forecasting. They are used in fluid 

dynamic calculations, nuclear energy research and petroleum exploration. 

 

Mainframe Computers 
 

They are very large and expensive computers which are capable of supporting hundreds or 

even thousands of users simultaneously. They process data at a very high speed, measured 

in millions of instructions per second. Mainframes are often servers that control a network 

of computers. They are used in banks, insurance companies, manufacturing units, mail order 

companies and airline companies. 

 

Micro Computers 
 

These are divided into two groups: 

 

 Personal Computers - They are standalone computers.


 Workstations - Workstations are specialised computers that are connected to 
networks of other computers.



Notebook and Laptop 
 

A notebook weighs less than two pounds and can fit into a briefcase, yet it can compete 
with a microcomputer. A larger and heavier version is called a laptop. 

 

Personal Digital Assistant (PDA) 
 

This is the smallest and handheld computer. PDAs are used to track appointments and 
shipments as well as names and addresses. 

 

Tablets 
 

A tablet is a mobile computer, larger than a mobile phone or a PDA. It is operated by 
touching the screen rather than using a physical keyboard. 

 

How does a computer work? 
 

A snapshot of the work process of a computer is as below:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

For example, you want a sum of three numbers - 321, 245 and 678. You provide this data as 

an input using the keyboard, then you instruct the computer to provide the sum of these 

three numbers. The computer takes the numbers and the instructions as an input. Then 

these numbers get processed in the CPU as per instructions and then the output or the sum 

is displayed on the monitor. All these happen within a blink of an eye. 



 
 

EXERCISE 1 

 

1. Which of the following is the largest and fastest computer?  
- Mainframe Computer  
- Super Computer  
- Micro Computer  
- Notebook 

 
2. Identify the correct definition of a Computer:  

- A computer is an electronic device to store data  
- A computer is an electronic device used to input data  
- A computer is an electronic device used to process data  
- A Computer is an electronic device used to store and process data 

 
3. A personal computer is a type of:  

- Personal Digital Assistant  
- Mainframe Computer  
- Micro Computer  
- Notebook 

 

 

Components of a Computer 
 

Computers are made up of different components - Input 

devices, Memory devices and Output devices. Input devices 

are those devices that can be used to insert data, instructions 

or information into a computer. A few input devices are 

mouse, keyboard, microphone, joystick and scanner. 
 

 

How do we provide input to the computer? 
 

We give data or instructions to a computer using input devices. A Keyboard is used to enter 
data into a computer. There are different types of keys and their functions:  
 
 

Typing keys: They include letters, numbers, symbols, 
punctuations and space bar. 
 

 

Control keys: Control key, alt key, the windows logo 

key and the escape key are the control keys. These 

keys are used alone or in combination with the other 

keys to perform certain actions. 
 



 

Function keys: These are labelled as f1, f2, f3, f4 and so 

on up to f12. The functionality of these keys differs from 

program to program and is used to perform specific 

actions. 
 

 

Navigation Keys: It means locating position. It helps 

you to move around in documents, data sheets, 

presentations or WebPages and edit text. These include 

the arrow keys, home, end page up, page down, delete 
 

and insert.  
 
 

The Numeric keypad is designed like a conventional 
calculator used to input numbers. 

 

What is a mouse and how is it used? 
 

A mouse is used as a pointing device to point to and interact with items on the computer 
screen. When you move the mouse, you can see a   

small moving arrow - this is called the ‘pointer’. The 

pointer can provide data or instructions to the 

computer for processing. A mouse has two buttons 
 

- left and right. It also includes a scroll wheel 

between the two buttons that helps you to move 

between documents and webpages more easily. 
 
 
 

Types of Output Devices: 
 

Output devices are used to display the result to 

the user. The main output devices are Monitor, 

Printer, Speaker, Headphones and Projector. 
 
 

Monitors: Monitor is the most common output 

device. Monitor is a screen used to display the 

output, such as words, numbers and graphics. 
 
 
 

 

Monitors are of 2 types - Cathode Ray Tube (CRT) and Flat Panel Displays. CRT’s are cheaper 

and have good viewing angle but they are bulky and consume more power. Flat Panel 

Displays are lighter and have no magnetic interference. They are also costlier. 
 



 

Printer: A printer takes the processed data from the 

computer (soft copy) and generates a hard copy of the 

same. They are commonly used to print text data and 

images. Soft copy is and image or text file viewed on a 

computers display whereas a hardcopy is the printed 

version of the same. 
 

 

There are three types of printers: Inkjet Printer, Laser 
Printer and Dot Matrix Printer. 
 
 

Speaker: A speaker is an output device through which we 

can hear sound. Without a speaker you will not be able 

to listen to music, hear an audio content, etc. 

 

Headphones: They give sound output from the computer. They are similar to speakers 

except that they are worn on the ears, so that only one person can hear the output at a 

time. 

 

Projector is an output device with which a text or an image is projected onto a flat screen. A 

projector is often used in meetings or to make presentations. It allows the display to be 

visible to many people. 
 
 

EXERCISE 2 

 

1. Which of the following device is used for inserting data into a Computer?  
 Monitor
 CPU
 Printer
 Keyboard



2. Which of the following is an output device?  
 Printer
 CPU
 Mouse


 Keyboard

 

What is a Computer Memory? 
 

When you know something, it is stored in your memory. In the same way, the place where 
computer stores data and programs is called Computer Memory. 

 

Computer has 2 types of Memory - Primary/Main Memory and Secondary Memory. 



 

The main memory is very fast. It is called 

Random Access Memory or RAM. Data and 

instructions are stored in the main memory 

from where it can be retrieved from Central 

Processing Unit (CPU) for processing results. 

RAM is the memory in which all the 

programs are stored. The speed of the 

computer depends on the RAM. Cache 

memory is a memory that is a part of RAM 

and is very near to the processor. It is used 

to improve processing speed. 
 

 

The primary memory is limited, so to store 

unlimited data we use secondary memory. 

Any data or program that is kept in 

secondary memory has to be copied by RAM 

because the computer cannot process data 

directly on secondary memory. 
 
 

The examples of Secondary Memory are – Pen Drives, Hard Disk, External Hard Disk, Floppy 
Disk, Magnetic Tapes, Magnetic Bubble Memories and Optical Memories. 

 

How does a computer store data in its memory? 
 

Computer stores all information in just two digits 0 and 1. A single binary digit, that is, a 1 or 
a 0 is called a bit. A group of eight bits is called a byte. 
 

 1 byte is equal to 8 bits.




 1 Kilobyte or 1 KB is equal to 1024 Bytes




 1 Megabyte or 1 MB is equal to 1024 KB




 1 Gigabyte or 1 GB is equal to 1024 MB


 

1.2 CONCEPT OF HARDWARE AND SOFTWARE 
 
 
 

All physical components of a computer that can be 

touched or felt are called Hardware. The electronic 

circuits and mechanical components such as Hard 

Disk, Printer, CPU, Keyboard and Mouse are 

Hardwares. 
 
 

Hardware devices are very important but they are 
useless without the instructions that control them. 



 

The Instructions that are used to control hardware and accomplish tasks are called 
Software. 
 

 

Software is a general term used for computer programs. These programs are planned step-

by-step set of instructions that direct the computer what to do and how to do. There are 

two types of software - Application Software and System Software. 
 
 

Application Software: An application is a job or a task that a user wants to accomplish 

through a computer. Application Software is a program that helps the user to perform a 

specific job. It enables a user to write a letter or create a drawing. Microsoft Word and 

Microsoft Paint are examples of Application Software. 
 
 

System Software: The programs that are directly related to the computer hardware are 

called System Software. For example, to run a computer you need an operating system, 

which is a System Software. 
 
 

 

EXERCISE 3 

 

1. Which of the following is System Software?  
 Ms Paint
 Ms Word
 Power Point
 Operating System



2. 1 Megabyte or 1 MB is equal to:  
 512 GB
 512 KB
 1024 GB
 1024 KB

 

1.3 SETTING UP AND WORKING OF A COMPUTER 

 

How do you use a computer?   

A computer or a computer system mainly consists of a 

system unit or case and other devices such as Monitor, 

Keyboard, Mouse, Speakers and Microphone. In order to 

use a computer we need to connect all the devices to 

the system unit. 

 

How do you connect a computer? 
 

You need to follow the following steps in order to connect a computer: 



1. Place the computer on a desk or table. 
 

2. Place the system unit next to the monitor because we need to connect a few wires 

between them. It can be under the table on a dry stool or beside the monitor. Be 

sure of the place where the system unit is to be kept. 
 

The place should be well ventilated and should have 

sufficient airflow which will prevent the system unit 

from overheating. 
 

3. The rear portion of the system unit has all the various 

connection slots or ports for connecting various 

devices. First, connect the monitor to the system unit. 
 

4. The video port of the system unit is called the VGA 

port. The colour of the video port and the connectors 

of the VGA cable are blue to make them easier to 

identify. Connect one end of the VGA cable to the video 

port in the system unit and the other end to the 

monitor. 
 

5. Now you need to connect the keyboard into the system 

unit. A keyboard has 2 types of connectors – PS/2 

connector and USB Connector. You can connect the 

keyboard to any of the 2 ports depending on its type. 

Desktop computer keyboard often comes with a PS/2 

connector. Connect the keyboard to the keyboard port 

of the system unit. 
 

6. A mouse has three models of connectors: (i) Mouse 

with PS/2 Connector; (ii) Mouse with USB Connector; 

and (iii) Mouse with Serial Connector. You need to 

connect the mouse in the appropriate port in the 

system unit. For example, if it has a serial connector, 

connect it to the serial port in system unit. 
 

7. Now, you need to connect the printer to the system unit. A printer has two models 

of connectors - Parallel Port Connector and USB Port Connector. You can connect the 

printer to any one of the two ports in the system unit depending on the type of 

connector in the printer. 
 

8. Now that all the main peripherals like the monitor, 

printer mouse and keyboard are connected to the 

system unit, all you have to do is to provide power 

supply to the system unit and the monitor using two 

power supply cables that come with the computer. Plug 

one power supply cable into the power supply plug in 

the system unit, plug another power supply cable into 

the monitor. Now plug both these power supply cables 
 



to the power plugs in a switch board. The computer system is now ready to be used.  

 

EXERCISE 4 

 

Identify the correct step to connect VGA cable to the system unit? 
 

 Connect one end of the VGA cable to the video port of the CPU, and the 
other to the switch board.


 Connect one end of the VGA cable to the video port of the CPU, and the 

other to the monitor.


 Connect one end to the power supply switch board, and the other to the 
CPU.


 Connect one end of the VGA cable to the video port of the CPU and the 

other to the keyboard.

 

Steps to start a Computer  
 
 

1. Switch on the power supply of both the system unit and 
the monitor. 

 
 
 
 

2. Press the power button of the system unit. It is usually 

located in the front side of the system unit. Ensure that 

the LED of the unit is switched on. 
 
 
 
 
 

 
3. Now, switch on the monitor. Press the power button on 

the front bottom side of the monitor. Ensure that the 

LED of the monitor is turned on. 
 
 
 
 
 
 
 
 
 

 

4. In few seconds, the display appears on the monitor. The 

boot screen could be seen as soon as the monitor starts. 

Wait until everything is loaded and Windows desktop 

screen is displayed on the monitor. Now your computer 

is ready to be used. 



 

COMMON TROUBLE SHOOTING 

 

Some common problems might occur even after you have started a computer. For example: 

 

Problem: You have switched on the power supply of the system unit and the monitor and 

pressed the power button of the system unit. Still the LED of the system unit is not ON and the 

system does not start. 
 

Solution: In this case double check if there is any loose connection in the cables. It is advised to 
remove it and plug-in again and try repeating the procedure of starting a computer. 

 

Problem: After starting the computer, the boot screen does not appear on the monitor. 
 

Solution: Check if the monitor is turned on, check the connection of the monitor or re-connect. 

 

Problem: The computer has started but you are unable to use the keyboard or the mouse. 

Solution: You need to check that the keyboard or mouse is connected to the correct port. 

Check the keyboard or mouse connector for bent, broken or missing pins. Also, you can try re-

connecting your keyboard and mouse, restart your computer and see if that fixes it. 
 
 
 
 

EXERCISE 5 

 

1. Identify the first step of starting a Computer  
 Press the “power” button of the monitor.
 Press the power button of the CPU.
 Switch on the power supply.
 Press the enter key.



2. Which of the following parts of the computer system is getting connected 
to the printer?  

 System Unit
 Monitor
 Mouse
 Keyboard



 
MODULE 1 - ASSESSMENT 

 

1. Which of the following is input?  
 The operation of data or information as per given instruction
 Letters, numbers and images
 The processed data or information given by a computer



2. Which of the following are the control keys?  
 Windows logo key and control keys
 F1, F2, F3 Keys
 Arrow and Delete Keys



3. Identify the output devices from the following  
 Mouse and Keyboard scanner
 Digital Camera
 Printer and Monitor



4. What is the significance of a projector?  
 In meetings or to make presentations
 In watching movies
 In playing video games



5. The place where computer stores data and programs is called?  
 Hardware
 Software
 Memory



6. The primary memory is also known as?  
 Auxiliary Memory
 Main Memory
 Secondary Memory



7. Which of the following is the correct procedure of starting a Computer? 
 

 Switch on the power supply, press the “power” button located on the system unit, 
press the power button of the monitor.


 Switch on the power supply; press the “power” button of the monitor, press the 

“power” button located on the system unit.


 Press the “power” button of the monitor, press the “power” button located on the 
system unit, switch on the power supply.



8. What should you do if the mouse is not working?  
 Change the mouse
 Check the mouse is connected to the correct port
 Check the keyboard connection to the system unit



 
9. How to troubleshoot, if LED of monitor is not turned ON while starting a computer? 

 
 Double check if there is any loose connection in cables or re-do the procedure 

again.
 Tap the Monitor.
 Press the space key.



10. Which of the following is Application Software?  
 Operating System
 MS- Excel
 CPU



2. OPERATING SYSTEM AND COMPUTER BASICS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

LEARNING OUTCOMES 

By the end of this module, you should be able to: 
 Describe the functions of Operating System
 Manage files and folders in a computer

 Use computer accessories

 

LESSON PLAN 

2.1 Getting started with Operating System 

2.2 File and Folder Management 

2.3 Using Accessories 



2.1 GETTING STARTED WITH OPERATING SYSTEM 

 

 

What is operating system? 
 

Operating System is a program that helps us to interact with other computer programs. The 

computer is useless without an operating system. There are various types of operating 

systems available today. 
 
 

Computers use a different language than us; this language is made up of digits. The 
operating system acts as an interpreter. It helps us talk   

to the computer. In simple language we can say that 

the operating system is an interface between user and 

computer. The Operating System also enables the user 

to effectively use the system resources and access 

other programs. All other programs need operating 

system to start them, but the operating system starts 

by itself. This is why when we switch on a computer 

we see the respective operating systems screen. The 

operating system starts the computer automatically 

when power is turned on. 
 
 
 

EXERCISE 1 

 

Which of the following statements are correct for operating system?  
 It is an interface between user and Computer

 It is application software
 It starts the computer automatically when power is turned on

 It starts itself
 
 

 

What are the functions of an Operating System? 
 

The major functions of the Operating System are:   

 It controls and coordinates the operation of a 
computer


 It eases the interaction between the user and 

the computer
 It controls input and output devices
 It controls execution of computer programs


 It manages the use of the main memory of 

Computer
 It helps the user to manage and manipulate files.



Popular Operating Systems 
 

There are number of operating systems available today. Some famous ones are:   

i. Unix  
ii. Linux  
iii. Windows 9x  
iv. Windows XP  
v. Windows NT 

 
vi. Windows 2000  
vii. Windows 8 

 
viii. Windows 7  

ix. Android  
x. Macintosh OS  

 
 

All these operating systems have some unique features. Android and Windows 8 are also 

used in mobile phones. Windows family of operating systems is the most popular operating 

system. This is made by the Microsoft Corporation of the United States of America. 
 
 

To learn about the version of a Windows operating system, you need to go to the desktop 

and right click on ‘Computer’ and select ‘Properties’. You can then see the name and the 

version of the Windows operating system. 
 
 

EXERCISE 2 

 

Identify the functions of an operating system:  
 It controls the input and output devices

 It manages the use of Computer Memory
 It starts automatically when the computer is switched on

 It controls execution of Computer Programs

 

Classification of Operating System 
 

 

Operating system can be user friendly with 

many icons and images or it can be just text or 

character based. The Operating System can be 

classified into 2 types: Character User Interface 

and Graphical User Interface. 
 



Character User Interface: Look at both the images above. The first one does not have any 

icons or images, it has only text and characters. Hence it is called Character User Interface 

(CUI). We perform any task on CUI by giving commands in texts such as re-name, CLS, CD, 

MD and DIR or directory. Example of CUI is Disk Operating System (DOS). 
 
 

Graphical User Interface (GUI): The second image has a background picture as well as many 

icons. Hence we call it a Graphical User Interface (GUI). Examples of GUI are Windows XP, 

Windows NT and Windows 7. 

 

More about GUI of Windows 7 
 

This interface makes it easy to interact with the applications 

that you want to use. It also helps you to use programs and 

keep them organised. Windows are a WYSIWYG kind of GUI, 

which means, ‘What You See Is What You Get’. If the 

Operating System in your computer is Windows, the first 

screen that appears after switching on your computer is the 

Desktop. You can use the windows desktop to keep all the 

applications and utilities organised in the computer. 
 

 

The desktop is divided into 2 areas - Main Area or the Desktop and the Task Bar. The narrow 

strip at the bottom is called the Task Bar. The task bar contains a start button that you can 

use to access all the programs of the computer. You can also pin the various programs to the 

task bar as icons to be used as quick access to the programs. The task bar also has a clock at 

the right side bottom of the desktop. The desktop has a background, which is called 

Wallpaper. 
 
 

EXERCISE 3 

 

Which of the following is an example of Character User Interface?  
 Windows 7

 DOS or Disk Operating System
 Windows XP

 Macintosh OS
 

 

2.2 FILE AND FOLDER MANAGEMENT 
 

 

Desktop 
 

The first screen that you get when you start and log on to your 

computer is called a Desktop. The small pictures on the desktop are 

called desktop icons. These icons represent shortcut for files, 

programs and folders which could be quickly and easily accessed. 



 

Task Bar 
 

The horizontal bar at the very bottom of the screen is called the 

Task Bar. The task bar also contains many icons and shortcuts. A 

task is any work that you perform on a computer. Windows 7 is a 

multi tasking operating system which means it can help you to do 

multiple tasks at a time, in other words it helps you to run more 

than one program simultaneously. The task bar displays all the 

running applications and programs as icons. It also helps you 

access many applications and programs in the computer through 

these icons. The task bar provides an easy way to switch between 

multiple programs running on the computer. If a number of 

applications are running and there is not enough space available 

on the task bar to keep all the icons, then similar types of icons 

can also be grouped together. 
 

 

Start Button 
 

Through the Start button, you can access programs and other 

system utilities. When you click on the start button, the start 

menu appears listing various programs installed the computer. 

You can use Control Panel in the start menu to change various 

 

hardware and software settings in your computer. You can also 

use Help and Support menu item in the start menu to get any 

help you need while working with Windows. With the help of 

start menu you can shut down your computer with a click only. 

You can also log off from the computer, switch between users, 

restart the computer and lock the computer using the start menu. 
 
 
 

 

Changing System Date and Time   

To change the system date and time, click on the date and time 

present on the right side of the task bar. After this, a clock and a 

calendar appear. Following are the steps to change the system 

date and time: 
 

Step 1: Click on the date and time on the taskbar 
 

Step 2: Click on the change date and time settings link   

Step 3: Click on the change date and time button 
 

Step 4: Set date and time 
 

Step 5: Click OK to save changes and return to the date and time 
dialog box 



Step 6: Click OK on the date and time dialog box to save changes and close the dialog box.  
 

EXERCISE 4 

 

1. System Clock is found at?  
 Desktop

 Taskbar
 Icons
 Under Start Menu



2. Which option is used to change various hardware and software settings 
of your computer?  

 Desktop

 Control Panel
 Taskbar

 All of these
 

 

Desktop and its Display Settings 
 

Desktop is the display area that you see when you log onto your computer. You can change 

the appearance and personalisation or the way the desktop behaves. The picture behind the 

icons is called Wallpaper or the desktop background. 
 
 

Just like you decorate your room and desk with pictures, you can decorate your desktop too 

by changing the wallpaper or desktop background. When you keep the computer idle for 

some time or if you do not work for a while on the computer, an animation of pictures or 

text appears on the screen. This is called a Screen Saver. 
  

You can set a screen saver of your choice or can even set a 

password and assign timing for the screen saver. Once you 

set the timing, the screen saver starts by itself when the 

computer is left idle. Assigning a password to your screen 

saver locks your screen, therefore, no one can access your 

desktop if you are away from your computer for a long 

time. You can also change the theme of your Windows 

appearance and can customise it as ‘My theme’. You can 

also change the colour of Windows by using the Windows 

colour icon. 

 

Changing Desktop Background 
 

You can change your computers wallpaper or desktop background with images and pictures 
of your choice. 



 

How to change a desktop background? 
 

When you right click on the empty space on the desktop, a 

popup menu appears. Click on the ‘Personalize’ option from 

the menu; personalization window appears on the screen. 

 

This window has options for changing the display settings. 
 

When you click on the desktop background link it shows a 

number of pictures which can be set as a background. You can 

choose a picture and set it as your desktop background. You 

can also browse pictures and set one as your desktop 

background. Click on the ‘Save Change’ button to save the 

changes. The background of the desktop will change. Minimise 

the personalisation window to check and verify the change of 

the desktop background. 
 

 

Steps to Change the Desktop Background 
 

Step 1: Right click on the empty space on the desktop 
 

Step 2: Click on the personalize option from the menu 
 

Step 3: Click on the desktop background link 
 

Step 4: Choose a picture and set it as your desktop background 
 

Step 5: Click on the save changes button to save the changes. 

 

Setting a Screen Saver   

Step 1: Right click on the empty space on the desktop 
 

Step 2: Click on the personalize option 
 

Step 3: Click on the screen saver link 
 

Step 4: Click on the screensaver dropdown menu and select 
a screen saver from the list 
 

Step 5: Set the time for the screen saver to start by selecting 
number of minutes from wait combo box 
 

Step 6: Click on the preview button preview the screen saver 
 

Step 7: Click on the apply button to apply the screen saver 
 

Step 8: Click on the OK button to save the changes. 



 

EXERCISE 5 

 

1. An animation of pictures or text that appears on screen if the system is ideal is called?  
 Wallpaper

 Screensaver
 Themes
 None of These.



2. Which are the correct steps used for changing wallpaper? 
 

 Right click on the desktop, click on the personalize option from the menu, click on 
the desktop background link, choose a picture and set it as your desktop 
background.



 Right Click on the desktop, click on the screen resolution option, click on the 
desktop background link, choose a picture and set it as your desktop background.



 Right click on the desktop, click on the personalise option from the menu, click on 
the display link, choose a picture and set it as your desktop background.



 Right Click on the desktop, click on the screen resolution option, click on the display 
link, choose a picture and set it as your desktop background. 

 
 

 

Files and Folder Management 
 

You can create folders in a computer to store computer files. 

 

What is a computer file? 
 

In a computer any self contained piece of information that is 

available to the operating system and individual programs is 

called a file. A file can be a document, an image, music or a 

movie. To keep several files at one place, you create a folder. 
 

 

Windows explorer on your computer window helps you to 

manage and view the hierarchy of folders on your computer. You 

can create a file or folder in any of the drives in the computer. 

You can create a file or folder on the desktop too. After creating a 

file or folder, you can either rename, copy, paste or simply move 

it from one location to the other. You can also delete a file or a 

folder if you do not require it. If you manage your files and folders 

well, it saves you a lot of time and helps you to work more 
 
 

efficiently. To manage files and folders, you need to be able to 
work with files and folders.  



Working with Folders 

 

How to create a folder in a drive? 
 

The following steps need to be followed to create a new 
folder in the drive:   

 Click on the start button to show the start menu.


 Click on the ‘Computer’ to display the computer 
window or windows explorer.


 Click on the ‘Local Disk (D:)’ icon to view the content 

in drive D.


 Click on the new folder in the menu bar to create a 

new folder. You can give name to the new folder and 

press enter or if you do not want to name the folder 

at that point of time, you can just press enter, which 

creates a folder with default name as ‘New folder’.



 Alternatively, right click on the empty space on the 

right panel of the selected drive, a popup menu 

appears. Point the mouse to the ‘New’ option and 

then click ‘Folder’. Press enter to create folder with 

default name as ‘New folder’.


 To rename the new folder, select the folder, click on the organize dropdown menu in 
the menu bar, select rename form the menu, type ‘Chetna’ and press enter.


 The new folder has been renamed to ‘Chetna’. A file or folder name cannot contain 

any of the following characters / \ : “ * ? < > | 

 

EXERCISE 6 

 

1. Any self contained piece of information is called?  
 File
 Folder

 Icon

 Taskbar



2. Which are the correct steps used to rename any folder? 
 

 Select the folder, right click on the organize drop down menu, select rename from 
the menu, type the new name and press enter.


 Select the Folder, right click on the organize drop down menu, type the new name. 

Press enter.


 Right click on the organize drop down menu, select rename from the menu, type 
the new name, press enter.


 Select the Folder, select rename from the menu, type the new name, and press 

enter.



2.3 USING ACCESSORIES 

 

Introduction 
 

Under this section, you will learn how to use various accessories of Windows such as Paint, 

Calculator and Notepad. To access these accessories in a computer, you need to follow 

these steps: 
  

 Click on the start button on the task bar
 Point the mouse to ‘All programs’
 Click on ‘Accessories’
 The various accessories are listed here
 Click on an accessory to access it.

 

Paint 
 

You can use paint to create drawings on a blank drawing area or in existing pictures. Paint is 

used to create, edit and view pictures. You can use self created pictures as our desktop 

background. You can also copy and paste a paint picture to any other document. 

 

Using Paint 
 

To run paint, click on the start button; point the mouse 

to all programs, click on accessories and select paint. The 

paint window appears. Or you can type paint in the 

search programs and files textbox in the start menu. 
 

 

The paint window is divided into 4 major areas: Paint 
button, Quick Access toolbar, Drawing area and Ribbon. 
 

 

Paint button: With the paint button you can perform 

various actions. The various options in the paint button 

are: Open, New, Save and Print. 
 

Quick Access toolbar: It helps you quickly access frequently used tools such as save, redo 

and undo. You can also customise the quick access toolbar by selecting items from the drop 

down list. 
  

Ribbon: A Ribbon contains two 
tabs - Home and View. 

 

Home tab: The home tab 
 

provides tools that help in creating and editing images. It provides many options that are 

majorly categorised into various sections like Clipboard, Image, Tools, Brushes, Shapes and 

Colours. 



 Clipboard: It consists of three options - Cut, Copy and Paste. By using these option 
you can cut, copy or paste a selected object in paint. These options help you use one 
object many times in a picture.




 Image: In this section, the various options that help you in selecting and editing objects 
are - Select, Crop, Resize and Rotate.




 Tools: It provides various tools that you can use to draw and edit a picture. These tools are 
Pencil, Fill with Colour, Text, Eraser, Colour picker and Magnifier.




 Brushes: This drop down menu helps you choose different kinds of brushes to draw a 
picture.




 Shapes: It provides various shapes that you can use in your picture. It also provides the line 
and curve tools to draw a straight line and a smooth curved line respectively.



 Colours: It provides a variety of colours to choose from while drawing a picture.


 

 

EXERCISE 7 

 

1. Tools like Pencil, Eraser, Text and Magnifier are found in?  
 Tools

 Clipboard

 Shapes
 Image



2. Which of the following is not the part of the paint window?  
 Paint Button

 Quick Access Toolbar
 Ribbon

 Writing area

 

What is a Notepad? 
 

You can write names and numbers or any textual detail or information on a Notepad. It is a 
text editing program. You can view and edit text files using a Notepad. 

 

How to open a Notepad file? 
 

 Click on the start button
 Point the mouse to all programs and click on accessories and then Notepad.


 The Notepad window appears or you can type Notepad in the search programs and 

files textbox in the start menu. The notepad window has a blank space where you 

can write, edit and view text.

 

Components of Notepad   

The menu bar of the Notepad file contains various items 
such as File, Edit, Format, View and Help. 



The File menu provides various options like New, 
Open, Save, Save As, Page Setup, Print and Exit.  
 
 
 
 
 
 
 

The Edit menu helps us edit text. It provides various 

options that are Undo, Cut, Copy, Paste Delete, Find, 

Find Next, Replace, Go to, Select All, Time/Date. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The Format menu helps you format all the text in the 

document; it has two options; Word wrap and Font. 
 
 
 
 
 
 

 

The View menu helps you view the status bar at 
the bottom of the notepad window.  
 
 
 
 

 

The Help menu provides two options View Help and 
About Notepad. 
 
 
 
 
 

 

How to use a Notepad? 

 

The steps to create a text file using Notepad are as follows: 
 

Step 1: Open the Notepad window. 
 

Step 2: Write text. 
 

Step 3: Select the text you want to copy. 
 

Step 4: Click the edit menu and select copy. 
 

Step 5: Put the cursor at the place where you want to paste the copied text. 



Step 6: Click on the edit menu and select paste. 
 

Step 7: Click on the edit menu and select Time/Date. 
 

Step 8: Click on the format menu and select Font. 
 

Step 9: Select the desired font type, style and size in the font dialog box. 
 

Step 10: Click on OK to save changes and close the font dialog box. 
 

Step 11: Click on the file menu and select save. 
 

Step 12: Select the desired location and folder, write the file name in the file name combo 
box. 
 

Step 13: Click save to save the file. 

 

How to insert current date and time? 
 

To insert date and time click on the edit menu and select Time/Date. You can now apply the 

desired font. To set the font, click on the format menu and select font. The font dialog box 

appears; select the desired font type, style and size in the font dialog box. Click OK to save 

the changes and close the font dialog box. Now to save this file, click on the file menu and 

select save. The ‘Save As’ dialog box appears. Now, select the desired location and folder 

and write the file name in the file name combo box. Now click Save to save the file. 
 

 

EXERCISE 8 

 

Which is not the menu item of menu bar?  
 File

 Edit
 Format

 Text editor
 
 

 

Calculator 
 

Calculator helps you to perform simple calculations such as 

addition, subtraction, multiplication and division. You can 

also use the calculator to do programming, scientific and 

statistical calculations. 
 

 

To run a calculator click on the start button, point the mouse 
to all programs click on accessories click calculator. The 
 

calculator window appears, it has a menu bar that contains various menu items such as view 
edit and help. 
 
 

The view menu helps you select the mode of the calculator that you want to use. These 

modes are standard, scientific, programmer and statistics .The view menu also provides the 

history option that you can select to keep track of all the calculations that calculator 

performs in a session. This option is available in standard and scientific modes only. If you 

select the digit grouping option it inserts a comma after every third digit on the calculator 



screen. The view menu also provides various options to select the type of calculation that 
you want to do. 
 
 

The edit menu helps you copy digits from the calculator screen and allows you to paste 
numbers and digits from the clipboard. 
 

 

The help menu helps you get any help if you need while working with calculator. Click on the 

calculator keypad to input numbers and operations alternatively you can use computers 

keyboard to input numbers and operations. The result is displayed on the calculator screen. 

It as easy as using a physical calculator. 
 

 

EXERCISE 9 

 

Which option in a Calculator inserts a comma after every third digit on a 
calculator screen?  

 Digit Grouping

 Statistic
 Unit Conversion

 Date Calculation 
 

 

MODULE 2 - FINAL ASSESSMENT 

 

1. Which is the correct step to open paint?  
 Start >All Programs >Accessories
 All Programs > Start > Control Panel

 Start > Control > Accessories


2. In paint, options like open, New, Print and save as is found on:  
 Paint Button
 Quick Access Toolbar

 Ribbon



3. Operating System can be divided into:  
 Character User Interface
 Graphical User Interface
 Both



4. System Clock is found at?  
 Taskbar
 Control Panel

 Desktop



5. To enter time/Date, go to:  
 Edit Menu > Time / Date

 Format > Time /Date

 Edit > Date / Time



 
6. Computer Calculator can perform:  

 Scientific Calculation
 Statistical Calculation

 Both of These



7. Which option in Calculator keeps the track of all the calculations that are performed in 
a session?  

 Digit Grouping
 History

 Basic


8. Which option is not true for Paint?  
 We can set Paint picture as a Desktop Background
 We can also perform simple calculation by using Paint

 We can also copy and paste Paint picture into any other document


9. To change wallpaper of the Desktop you will use:  
 Changing screen saver option
 Changing Desktop Background option

 Changing Theme



10. In Paint, options like Line, Curve and Circle are found on:  
 Tools
 Shapes

 Clipboard



3. USING THE WORD PROCESSING PROGRAM 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

LEARNING OUTCOMES 

By the end of this module, you should be able to: 
 Create and Identify MS -Word as a word processor
 Create and Manage Documents

 

LESSON PLAN 

3.1 Getting started with Microsoft Word 

3.2 Creating and Managing Documents 



3.1 GETTING STARTED WITH MICROSOFT WORD 

 

Introduction 
 

The Microsoft Office Suite has one of the most used applications such as MS Word, MS Excel, MS 

Power Point and MS Access. Microsoft Word, MS Word or Word is a Word Processing Programme 

which is used to increase the readability of any text. It also helps in sharing data and documents, 

use communication tools, access the internet and edit, format, print or publish documents. By 

using MS Word you can create various kinds of documents such as letters, memos and reports. 

You can apply various font styles, font colour, insert pictures, graphs and tables into a document. 

 

How to run MS Word 
 

1. To run MS word click on the start button  
2. Point the mouse on All Programs  
3. Click on Microsoft Office  
4. Click Microsoft Office Word 2007 

 

 

MS Word is divided into various parts, which are: Title Bar, Quick Access Toolbar, Ribbon, Ruler, 
Workspace or Text area, Scroll Bar and Status Bar.  



Details about the various components of MS Word 
 

 The Title Bar: The Title Bar is the top most section of the Word window. It displays the 

name of the current document and the program name. The size of the document can be 

altered by double clicking on the title bar. The title bar contains the Office button, 

Minimize, Restore Down or Maximize and Close buttons.
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

- The Office button displays the list of recent documents. You can click on the name of 

the document from the list to access it quickly. The Office button also provides 

various options like Create, Open, Save, Print and Publish a document. 
 

- The Minimize button minimizes or reduces the document window to a task bar icon. 
By clicking on the icon, you can restore the window to its previous position. 

 
- Restore Down button restores the document window to its original size before full 

screen. Maximize button helps to maximize the document window to full screen.  
- Close button helps you close the document window and exit the word application. 

 
 
 Quick Access Toolbar: Helps you to quickly access frequently used 

tools such as Save, Redo and Undo. You can also customize the Quick 

Access Toolbar by selecting the items from the drop down list. By 

default, it is placed above the Ribbon. You can customize its location 

by selecting ‘Show below the ribbon’ option from the drop down list. 

You can also add items to the quick access toolbar. Right click on any 

item in the Office Button or the Ribbon and click on ‘Add to Quick 

Access Toolbar’ and a shortcut will be added.



 The Ribbon: Various menu items are arranged at the top of the ribbon as tabs like Home, 

Insert, Page Layout, References and so on. Clicking the tab displays all related menu options in 

the various groups.



 Ruler: The ruler helps you measure and line up objects in the document quickly. If the ruler is 
not visible click the view tab and choose the ruler option from its menu.




 Workspace or Text Area: The wide white space in the middle of the document is the 

workspace or text area which you can use to create a document. The horizontal and vertical 

scroll bars help you move up, down and across your document.
 



 The Status Bar is located at the bottom of the document window. It displays the information 

such as the current page and number of words in the currently active document. You can 

customize the information that you want to display in the status bar.
 
 

  EXERCISE 1   

1. Which of the following is not an application of Microsoft Office?  
a. MS Word B. Notepad c. MS PowerPoint d. MS Excel 

 

2. Identify the part of the document window that displays the name of the currently 
active document.  
a. Ribbon b. Ruler bar c. Scroll bar d. Title bar 

 

3. Which of the following part of the document window helps you move across the 
document?  
a. Ruler B. Ribbon c. Scroll bar d. Title bar 

 

 

Learning more about the Ribbon 
 

The ribbon consists of various menu tabs that help you access program features. These tabs are 
Home, Insert, Page Layout, References, Mailings, Review, View, Design and Layout.  
 
 
 
 
 
 
 
 
 
 
 

 

 The Home tab helps you format text and paragraphs. It contains menu options in various 
groups. These groups are Clipboard, Font, Paragraph, Styles and Editing.


- The Clipboard menu contains the cut, copy, paste and format painter options. The 

cut, copy and paste options help you to move or copy any selected text in a 

document. The format painter helps you copy the format and apply it to another.  
- The Font group helps change the font face, size, type and colour of the selected text. 

 
- The Paragraph group provides the option to align and indent text in a paragraph. It 

also helps you apply list, bullet and numbering to a paragraph and sort the selected 

text and numerical data. 
 

- The Styles group helps you apply various styles such as normal, no spacing, heading 1, 
heading 2, title and sub-title to the selected text in the document. 

 
- The Editing tab helps you find and search in the document. You can also use the 

replace option to replace a text and its various occurrences in the document 
 
 

 The Insert tab helps you insert Pages, Tables, Illustrations, Links, Header & Footer, Text 
and Symbols into the document.



 The Page layout tab provides the option to apply themes to the document like set up a 

page, apply page background, apply paragraph indention and spacing and arrange various 

objects in the document.


 The References tab helps you create the Table of Contents, insert Footnotes, Citations and 
Bibliography, Captions, Index and Table of Authorities.


 The Mailings tab helps you form document or letter where each copy is intended to be 

sent to multiple recipients. The various groups in the tab helps you create labels and 

envelop, include recipients to your document, write and insert fields such address and 

greeting line and preview the results and check for errors before finalizing. Mail merge is 

an important feature in MS Word, wherein you can write a customized flyer or letter to all 

your friends in one shot.


 The Review tab provides various options for proofing the document by inserting, deleting 

and navigating through the contents of the document, tracking changes in the document, 

viewing and navigating through the changes in the document, comparing multiple versions 

of the document and protecting the document.


 The View tab helps in working with the views of the document by helping in choosing the 

option of showing or hiding the ruler, grid lines, message bar, document map and thumb 

nails. The zoom group helps you view the document in a particular size. The window 

groups helps you arrange the various document windows open in the application.
 The Design tab helps you apply various styles to the table in the document.


 The Layout tab helps work with table. It helps you view properties of the table and work 

with rows and columns of the table. 

 

  EXERCISE 2  

1. What does the Ribbon consist of?    
a. Tabs   b. Page Number c. Name of the document d. Customize quick access 

tool bar     

 

2. Which of the following menu tabs helps you access the page background features like 
Watermark, Page borders and Margins?  
a. Home tab b. Page layout tab c. Insert tab d. Review tab 

 

 

3.2 CREATING AND MANAGING DOCUMENTS 

 

Creating and Saving a Document 

 

Steps to Create and Save a new document: 
 

Step 1: Click on the Start button 
 

Step 2: Point the mouse to All Programs 
 

Step 3: Click Microsoft Office 
 

Step 4: Click Microsoft Office Word 2007 
 

Step 5: Click on the Office button and select Save 
 

Step 6: Choose the location and folder 



Step 7: Write file name in the File name combo box 
 

Step 8: Select the type of document from the Save As type dropdown list 
 

Step 9: Click Save.  
 

 

EXERCISE 3 

 

Identify the correct set of steps to create a new document: 

 

a. Click start – All Programs – Microsoft Office- Microsoft Office 2007 
b. Click Start – All Programs – Microsoft Office – Microsoft Word 2007 
c. Click Office Button- Open- Click on the display link – New d. Click 
Office button – Save 

 
 

 

Opening an Existing Document 
 

You may be required to re-open a saved document for 

adding some text or editing some part of it. The office 

button provides an option, ’Open’, to open an existing 

document. 
 

 

In the Open dialogue box, you can explore the saved 

document and click Open to open the document. The 

open drop down menu provides options to open the 

document as Read only, as a copy to open and repair. By 

default all documents are saved in the ‘My Document’ 

folder. Therefore, open option by default opens ‘My 

Document’ folder. To open the files saved in another 

folder, you need to browse through the folder in the 

open dialogue box. You can also open non word 

document using the open option. In the Open dialogue 

box the drop down menu box to the right of the dialogue 

box allows you to select the type of document you want 

to open. The drop down menu lists the type of menu as 

displayed on the screen. 
 

 

The steps to open an existing document: 
 

Step 1: Click the Office button 
 

Step 2: Select Open to display the Open dialogue box 
 

Step 3: Double click the drive in which the folder containing the document located 
 

Step 4: Double click the folder to open it 
 

Step 5: Select the document that you want to open 
 

Step 6: Click Open to open the selected document. 



Editing Text in a Document 
 

This section deals with how to Insert, Delete, Modify and Copy text in a word document. Before 

you start inserting any text, you can see that the cursor is blinking at the starting point of the 

document. This means that whatever you write in a new document, it starts from the location 

where the cursor is blinking and as you type the cursor moves forward. You press spacebar in the 

keyboard to put one space after a word or a character. When you reach at the end of the line, 

Word automatically helps wrap the text to the next line. 
 
 

When you press the Enter key, the cursor moves to the next line. This allows you to write text in a 

new line. You can also insert pages, table, illustrations, links, header and footer, symbols and 

other objects like word art, text box and date and time using the insert menu of the ribbon. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Editing text in Document 
 

You must move the cursor to a place where you have to make changes. The arrow 
keys in the keyboard help you to move around in a document.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Up arrow, Down 

arrow, Left arrow, 

Right arrow 

 
 
 
 
 

The various arrow keys and their function are given below:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

In order to edit a document, you can insert, delete, copy, cut and paste text. Word is usually in an 

insert mode as in type in text it is pushed to the right and down. To delete text, you need to press 

either the backspace or the delete key. The delete key removes the characters from its current 

cursor position. The backspace key moves one position from the current cursor position. 



Backspace key 

 

Delete key 
 
 
 

 

You can also Redo and Undo the modifications that you have done in the current document from 

the Quick Access Toolbar. The undo command helps reverse actions. This could be done by 

pressing the CTRL Z key together. The redo command helps reverse the last undo. Therefore, if 

you want to restore the last deleted text by undo command, the redo command will again delete 

it. To redo a change, you need to click the redo button in Quick Access Toolbar or press the CTRL Y 

keys together. While editing a document you can also copy or cut text, line or paragraph and paste 

it to other place in the document. To copy or cut text you must first select it (You can select text 

using keyboard, mouse or both). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Cut & Paste: To move a text in a document, click on the text and click on the cut and move the 
cursor where you want the text to be pasted. Click on the paste option to paste the text. 
 

Copy & Paste: To copy texts, select the text to be copied, click on the copy option on the home 

menu of the ribbon. Place the cursor to the point where you want to paste the copied text. Click 

on the paste option, the copied text gets pasted. 
 
 

EXERCISE 4 

 

1. Which of the following key helps put one space after a word or a character? 

a. backspace b. CTRL c. Spacebar d. Right arrow 

 

2. Which of the following keys help you navigate to the next word in a document? 

a. Home + Right arrow b. Ctrl + Right arrow c. Alt + Right Arrow d. Shift + Right arrow 

 

3. Which of the following key combination helps undo the task? 

a. Ctrl+Y b. Ctrl+U c. Ctrl+Z d. Ctrl+A 
 

 

Formatting Text in a Document 
 

Formatting text includes selecting fonts, changing case, aligning text, indenting paragraphs and 
applying bullets and numbers.  
 
 

Font is the style or manner in which the text is displayed in a word 
document. A font has face, style, size & colour as its attributes. You can 



select or change these attributes to change the appearance of text in a document. You can select a 

Font face from the font face drop down list. You can also select the size of the font by using the 

Font size drop down menu. You can change the font style of the selected text to Bold, Italics and 

Underline by clicking on the font style toolbar buttons. You can also change the colour of the 

selected text by selecting a colour from the font colour drop down menu. 
 
 

Changing Case: To change a case of the text first you need to select the text and then click on the 

change case drop down menu to select a case option. The drop down menu provides various case 

options as displayed on the screen: 
 

 Sentence Case: Capitalizes only the first letter in 
the selected sentences.


 Lower Case: Corrects all the select text to 

lowercase letters.


 Upper Case: Converts all the selected text to 
uppercase letters.


 Title Case: Converts first characters of each word 

to uppercase letters.


 Toggle Case: Changes uppercase to lowercase and 
lowercase to upper case in all the selected text. 

 
 

Alignment helps you to align text in a document. In a word document you can left align, right align, 
centre align and justify the text to enhance the readability.  

Left align, Right  
align and  
Center align 

 
 
 
 
 
 
 

Indents: You can indent paragraphs to make the text 

more readable in a document. Indents increase the 

wide space from the margin and decrease the text 

area for specific paragraphs. You can use these to 

increase and decrease indents in the text of a 

paragraph. 
 
 

Bullets & Numbering: You can make bulleted or numbered 

text in the document. You can use Format Painter on the 

Standard toolbar to apply text formatting and some basic 

graphics formatting, such as borders and fills. 

 
 
 
 

 

Left indent and  
right indent  



 
EXERCISE 5 

 

Which of the following group provides option to align text to the right of the margin?  
a. Styles 
b. Paragraphs 
c. Font 
d. Clipboard 

 
 

Working with Tables 
 

Tables help us to manage information in various kinds of documents such as forms, scripts and 

reports. Tables are made up of rows and columns. An intersection of rows and columns is 

called a cell that can contain data. 

 

How to create or draw tables in MS Word   

1. Place the cursor at the insertion point where you want to create 
the table  

2. Click on the insert menu on the ribbon  
3. Select the table drop down menu 

 
4. Select or write the desired number of rows and columns in the 

table  
5. Click OK and close the insert table dialogue box 

 

How to change the width and height of a cell 
 

Place the cursor on the cell, row or column and right click on it; a popup menu appears. Click on 
the table’s property option. The table properties dialogue box appears. 

 

How to insert a Row or Column   

1. Place the insertion point in a row below the location where 
you wish to add a row or column.  

2. Right-click the mouse. A menu appears  
3. Select insert row or column 

 

How to delete a row or a column 
 

1. Select the row or column to be deleted  
2. Right click you mouse and a menu appears  
3. Select Delete Column or Delete Rows 

 

Utility Options 
 

MS Word also provides various utility options such as Proofing, Comments, Tracking, etc. to help 
us review and track changes made in a document through the Review menu in the ribbon. 
 

 The Proofing group has options like - 

Spelling & Grammar, Thesaurus, Translate, 

etc. that help us proof text in a document.
 



- Spelling & Grammar: Spelling and Grammar errors are displayed by a red and green 
underline, respectively. To spell check the 

 
entire document or a part of the text, you need 
to click on this option. 

 
- Thesaurus: This is used to find similar meaning 

of a word. You just need to select the word and 

then click on Thesaurus. A research task pane 

appears on the right side of the window listing 

words of similar meanings. Point the mouse to 
 

the word and select insert from the drop down menu to replace the selected word 
with the suggested word. 

 
 Comments: You can also add your comments in a 

document. To add a comment, place the cursor at 

the point where the comment has to be inserted 

or select the text and then click on New 

Comment in the Comments group of the review 

menu. A comment text box appears to the right, 

wherein you can type your comments.

 Tracking: By selecting the Track Changes option 

in the Tracking group, you can track all changes


made to the document including insertions, deletions and formatting changes. The 

changes made in Track Change mode helps you to identify the changes made to the 

document. You can also accept or reject changes using the options available in the 

Changes group.
 



4. USING SPREADSHEET 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

LEARNING OUTCOMES 

By the end of this module, you should be able to: 

 Learn and Identify MS Excel as an Electronic Spreadsheet
 Confidently use and work on Excel Worksheets

 

LESSON PLAN 

4.1 Getting started with MS Excel 
4.2 Working with Worksheets 



4.1 GETTING STARTED WITH MS EXCEL 

 

Introduction 
 

MS Excel is an electronic spreadsheet which simulates a paper worksheet that you use in 

your accounting and data managing tasks. MS Excel provides various features such as fast 

calculations, what-if analysis, graphs and charts and automatic update of calculations. It has 

a very powerful and flexible graphical presentation tool called Graphs or Charts. Large and 

complicated data can be presented through graphs and charts for quick analysis of a 

situation. By using this program, you can create, store, calculate simple, large and complex 

data or budgets and also create various accounting reports such as cash flow statement, etc. 

 

Running and Starting an Excel Program 
 

1. Click on the Start button  
2. Point the mouse to All Programs  
3. Click on Microsoft Office  
4. Click on Microsoft Excel 2007  

 
 

The window that opens up is the workbook where MS Excel 

stores all its data. It is a collection of various worksheets 

each of which can store data. A worksheet in excel is made 

up of rows and columns, with each workbook containing 

65,536 rows and 256 columns. 
 
 

By default a new workbook has three worksheets - Sheet 1, Sheet 2 and Sheet 3 – which 
appear at the bottom of the workbook. 

 

Renaming a Worksheet 
 

1. Double click the Sheet tab that you want to rename  
2. The existing name in the Sheet tab gets selected 

 
3. Write the new name that replaces the existing 
name Alternatively,  
1. Right click on the sheet tab that you want to rename  
2. Select rename from the short cut pop up  
3. Write the new name that replaces the existing name in the pop up 

 

Adding Worksheets in a Workbook 
 

MS Excel allows you to either add a new worksheet or delete an existing worksheet either at 
the end or before and after an existing worksheet. 
 

 To insert a new worksheet at 

the end of an existing 

worksheet, click on the Insert 

Worksheet tab at the end of 

the Sheet tabs. A new


worksheet with its default name is inserted at the end of existing worksheets. 



 To insert a new worksheet before an existing worksheet, select the worksheet and
 

click Insert in the Cells group of the Home tab. Click Insert Sheet and a new sheet 
with its default name is inserted.   

Alternatively, 
 

1. You can also right click on an existing sheet tab and 
then click Insert. 

 
2. An Insert dialogue box appears, click on Worksheet 

and then click OK to insert a new Worksheet.  
 
 
 

EXERCISE 1 

 

How many Rows and Columns does a worksheet contain? 

a. 63556 rows and 246 columns 

b. 63556 rows and 256 columns  
c. 65536 rows and 256 columns 

d. 63556 rows and 246 columns 
 

 

Creating and Saving a New Workbook    
 

Step 1: Click on the Start button 
   

 

 Office button  
 

    

Step 2: Point the mouse to All Programs 
    

   
 

Step 3: Click Microsoft Office 

    

   
 

Step 4: Click Microsoft Office Excel 2007    
 

Step 5: Click on the Insert Worksheet tab at the    
 

end of the sheet tabs    
 

Step 6: Double click the Sheet 1 tab    
 

Step 7: Type the desired name for Sheet 1 
   

 

   
   

Step 8: Click on the Office button and select Save 
 

Step 9: Choose the location and folder 
 

Step 10: Write the file name in the File name combo box 
 

Step 11: Select the type of the workbook from the Save As type dropdown list. 
 

Step 12: Click Save.  

 

Printing of Workbook in MS Excel 
 

1. Click on the Office button  
2. Point the mouse to print and select Print Preview 

 
3. Select Print Preview to have a print preview. The preview 

option helps us to make changes to the worksheet before 

printing. We can also change or modify margins. 
 

 

Printing a particular section of the Workbook 
 

1. Select the area to be printed and click on the Office button 
 

2. Point the mouse to Print and click the Print option. The dialogue 
box appears; click the Selection button in the ‘Print what’ section.  

3. Click OK to print the selected area or range. 



EXERCISE 2 

 

We can insert a new worksheet only at the end of the worksheet: 
a. True 
b. False 

 
 
 
 

4.2 WORKING WITH WORKSHEETS 

 

Worksheet Cells 
 

Each worksheet is made up of rows and columns. An intersection of rows and columns is 

called a Cell and these are the cells that contain data. For easy reference each cell is given a 

name from its intersection such as the cell in column A and row 5 is called A5 and is 

displayed in the name box below the ribbon. A group of adjacent cells is called a range. For 

example, range of cells from A1 to A5 is denoted by A1:A5. 

 

Entering values or data in a cell   

Click on a cell to make it active, you can see a rectangular 

boundary over the cell. This indicates that the cell is active; 

then you can enter data into it. This can be numbers, text, date 

or time. 

 

To enter text or number in a cell: 
 

1. Click on the cell  
2. Type the number or text that you want to enter  
3. Press Enter or Tab 

 

To enter a date in a cell: 
 

1. Click on the cell  
2. Enter a date using a slash mark (/) or a hyphen (-) to separate the parts of a date  
3. Press enter or tab 

 

For example: To enter the time that is based on a 12 hr clock enter the time followed by a 
space and then type A or P by default MS Excel enters the time as AM or PM. 
 

To enter the same data in several cells: 
 

1. Select the cells into which you want to enter the same data  
2. Type the data in the active cell  
3. Press CTRL+ Enter 

 

Creating Text, Number and Date Series 
 

To type a series of text, number or time, MS Excel offers auto fill features that you can use 

to automatically fill cells with data that follow a pattern or data from a series. A series can 

be a sequence of days or months. 

 

Steps to create a series of text entries of days of a week: 
 

1.  Enter the first value i.e. first day of the series at the beginning of the series 



2.  Drag the auto fill handle across the cell you want to fill  
 

Auto fill handle  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Similarly, a series of month names as well as data could be filled in the cells.  

 

EXERCISE 3 

 

Through which of the following ways you can enter the same data into several cells? 

a. Using ctrl + Enter 

b. Using the fill handle 

c. None of the above  
d. Either of the options a or b 

 

 

Editing Worksheet Data 
 

The editing may include clearing of cell data and moving data from one location to the other. 
 

You can edit data by using the formula bar or editing it in the cell itself. 

 

To edit the cell content using the formula bar:   

1. Select the cell to be edited. 
 

2. Click on the formula bar present below the 
ribbon 

 
3. Edit the cell content as required and press 

enter 

 

To edit the cell content in the cell itself: 
 

1. Select the cell to be edited  
2. Press the F2 function key  
3. Edit the content by moving the cursor to the editing point  
4. Press enter or tab 

 
 
 
 
 

 
Formula Bar 

 

 

Note: Clearing a cell is not the same as deleting a cell. When you delete a cell, other cells to 

the right or bottom shift. Clearing a cell, on the other hand, does not cause the other cells to 

shift. 



To clear the cell using short cut menu: 
 

1. Select the cell to be cleared  
2. Right click on the selected cell 

 
3. Select Clear Contents option from the shortcut 

menu. 
 
 

You can also clear the cell using the delete key. Select the cell to be cleared and press the 

delete key. The delete key clears all the contents from the cell but does not change cell 

formatting. 

 

To clear the cell using the Menu bar:   

1. Select the cell to be cleared 
 

2. Click on the clear drop down menu in the 
Editing group of the Home tab.  

3. Select Clear Contents from the menu 
 
 

At times you need to create multiple copies of worksheet data. You can do this by using 

copy and paste options in MS Excel. You can copy the contents of the cells and paste in 

many cells, thus saving the effort of typing again and again. 

 

How to copy and paste the cell contents using the menu bar: 
 

1. Select the cells having the content to be copied 
 

2. Click on the copy option in the clipboard group of 
home tab 

 
3. Select the cell(s) in which you want to paste a copy of 

the data 
 

4. Four click on the paste option in the clipboard group 
of home tab 

 
5. Select paste to paste the copied contents in the 

selected cells(s).  

 

To copy and paste cell contents using Shortcut menu:   

1. Select the cell(s) having the contents to be 
copied  

2. Right click on the selected cell(s)  
3. Select copy from the short cut menu 

 
4. Select cell(s) in which you want to paste a copy 

of the data  
5. Right click on the selected cell(s)  
6. Select paste from the short cut menu 



To move data from one cell to another: 
 

1. Select the cell(s) having the contents to be moved  
2. Click the cut option in the Clipboard group of Home tab  
3. Select the cell(s) where you want to move the data  
4. Click on the paste drop down menu in the clipboard group  
5. Select paste to paste the contents in the selected cell(s) 

 

Changing Cell Size 

 

Changing Column Width   

1. Click on the column heading 
 

2. Click on the Format drop down menu in the 
cells group of Home tab  

3. Select the Column Width option 
 

4. Enter the desired Column Width in the Column 
Width text box  

5. Click OK to apply the change. 
 

 

When you select the auto fit column width option, MS Excel automatically resizes the 

column width to accommodate cell contents. You can also use the mouse to increase or 

decrease the column width by dragging the border of the column. 
 

 

Position the mouse pointer on the right hand border of the column 

header. Press the left button of the mouse and drag it toward the right 

to increase the width and towards the left to decrease the width. 

Release the mouse button when the desired width is set. 

 

Changing Row Height 
 

1. Click on the row heading 
 

2. Click on the Format drop down menu in the cells 
group of the Home tab  

3. Select the Row Heights option 
 

4. Enter the desired row height in the Row Heights text 
box  

5. Click OK to apply the change in row height.  
 
 

 

EXERCISE 4 

 

Which of the following options helps you delete cell contents? 

a. Delete b. Clear c. Format d. Cut 



Formula and Functions 
 

MS Excel provides Formulas that help perform calculations on values in the worksheet. 
 

Formulas are equations that start with an (=) sign. For example = 5+3 formula gives sum of 8. 
 

A Formula can contain any or all of the following:  
 
 
 
 
 
 
 
 
 
 
 
 

 

A Function is a prewritten formula that takes a value 

or values, performs an operation and returns a 

value/values. We use function to simplify and shorten 

formulas in the worksheet. The Insert Function option 

in the function library option helps us to insert various 

functions and formulas. These functions are SUM, 

Average, Max and Count as displayed on the screen. 
 

 

An Operator is a sign or symbol that specifies the type of calculation to perform within an 

expression. The different types of operators are – Mathematical, Comparison, Logical and 

Reference. 

 

Constant is a value in a formula that is not calculated and, therefore, does not change. 

 

How to create a simple formula with constants and calculation operators:   

1. Click the cell in which you want to enter the formula  
2. Type =  
3. Enter the formula 

 
4. Press enter. The result of the formula is displayed in the 

cell 
 

 

If you have to calculate the sum of all the numbers in column A, then use the formula with 
the function SUM. 

 

How to create a formula with the SUM Function:   

1. Click the cell in which you want to enter the 
formula 

 
2. Click on the Insert Function option. Alternatively, 

you can use the insert function icon on the 

formula bar  
3. Select the SUM function  
4. Click OK. A Function Argument dialogue box will 



appear 
 

5. Select the cell references as an argument in 

number one argument box. On the worksheet, drag 

the cursor down to the numbers to be added  
6. Click OK.  

 

How to use the AutoSUM option: 
 

1. Click the cell in which you want to use the formula  
2. Click on the AutoSum drop down menu  
3. Select the function SUM  
4. Select the cell ranges  
5. Press Enter.  

 
 

 

EXERCISE 5 

 

Identify the correct formula for finding the sum values in the cells from A5 to A8. 
a. =Sum (C6:C8) 
b. =ADD (C6:C8) 
c. =Sum (C6; C8)  
d. =ADD (C6; C8) 

 
 

Using Charts 
 

MS Excel allows you to represent data in a more eye catching way by using charts or graphs. 

Creating a chart in MS Excel is quick and easy. It provides a variety of chart types that you 

can choose from when you create a chart. 

 

Creating a Chart in MS Excel   

1. Create the data in the worksheet that you want to 
represent in the chart 

 
2. Select the cell that contains the data that you want 
to use for the chart  
3. Click on the Insert tab  
4. Click on the chart type option in the charts group  
5. Select a chart type from the displayed list 

 
 

A chart is inserted in the worksheet as an embedded 

chart. When you create a chart the design, layout and 

format tabs are displayed in the ribbon. The various 

options in these tabs allow you to modify the chart. The 

layout tab allows you change the display of the chart 

elements such as chart titles and data labels, use 

drawing tools or add pictures or texts to the chart. The 

format tab helps you to fill colour and change line styles 

or apply special effects to the chart. 
 



5. MAKING SMALL PRESENTATIONS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

LEARNING OUTCOMES 
 

By the end of this module, you should be able to: 
 

 Explain the benefits and features of PowerPoint
 Use PowerPoint to prepare and present slides

 

LESSON PLAN 
 

5.1 Getting started with MS PowerPoint 
 

5.2 Presentation of Slides 



5.1 GETTING STARTED WITH MS POWERPOINT 

 

PowerPoint Basics 
 

PowerPoint is presentation software or programme. It is used to create 

onscreen presentations. It has texts, pictures, sound and animation. 

Using presentations, you can present information or data in a more 

interesting and eye catching 
  

way. It also offers various design elements like auto layout 

and presentation templates that you can use to make some 

interesting presentations. You can generate speaker’s notes 

and audience handouts from your presentations. You can 

also organize presentation content with outlines. 

 

How to run PowerPoint   

1. Click on the start button  
2. Point the mouse to All Programs  
3. Click on Microsoft Office  
4. Click Microsoft Office PowerPoint 2007 

 
 

 

A presentation window has various parts common to other office applications such as MS 

Word and MS Excel with some tabs like Animation and Slide Show specific to PowerPoint. 

The presentation area is divided into 3 sections: 
 

1) The default or the normal view of the presentation.  
2) The panel to the left displays list of slides and outline. 
 
3) The panel at the bottom has text area where you can write notes that can be added to 

the slide.  

 

EXERCISE 1 

 

A PowerPoint presentation can contain: 
a. Image 
b. Text 
c. Sound 
d. All of the above 

 

 

Creating a New Presentation Using a Template 
 

To create a presentation using a template, click on the Office button and select the New 
option. The new presentation dialogue box appears which is divided into 3 sections: 
 

a) The left most sections lists the various types of templates.  
b) The middle sections lists and displays all the available option of the selected type.  
c) The third and the right most provide the preview of the template. 



 

Select a template from the new template dialogue box 

which creates a default presentation that does not 

contain any style or colour. The Installed Templates 

option lets you choose a template from the prebuilt 

templates of PowerPoint. A template provides layout and 

place holders for arranging text, images or other objects 

in a new presentation. Choosing a template from this 

option saves time and effort in creating layouts for new 

templates. Click the create option in the right hand corner 

of the dialogue box to create a template. 
 

 

Creating and Saving a New Presentation 
 

Step 1: Click on the Microsoft PowerPoint 2007. A new presentation as Presentation1 is 
created   

Step 2: Click on the Office button and select Save. Save As a dialogue 
box appears 
 

Step 3: Choose the location and folder in which you want to save the 
presentation 
 

Step 4: Double click the folder to open it and write the desired file 
name for the presentation in the File Name combo box 
 

Step 5: Click on Save to save the presentation and close the save as dialogue box.  

 

EXERCISE 2 

 

Which of the following statements are correct? 
 

a. We can generate speaker’s notes from a PowerPoint 
presentation b. We can get audience handouts from a presentation  
c. We can organize the PowerPoint presentation content with outlines. 
d. All of the above 

 

 

Editing Slides 
 

A PowerPoint presentation contains many slides. A slide in a PowerPoint is like a page in MS 
Word or a worksheet in MS Excel. It is the slide which   

contains text, images and other objects. A slide consists of 

a documentation area that is normally divided into title 

and subtitle parts. Both these parts contain place holders; 

a faint dotted line appears around each place holder. Click 

anywhere within the place holder to select it. When you 

type a text in the place holder it replaces the sample text 

with your text in the place holder. Also the faint dotted 

line around the place holder disappears. 



 

After entering a text in the place holder, click on a blank area of the slide to exit the place 
holder. 
 

 

If you want to add Text Boxes in the slide, then 

click on the Insert tab and select the Text Box 

option. Now click on the slide where you want to 

insert the text box. A text box with insertion box 

appears; when you type in the text box the text is 

resized according to the text entered in it. 
 

 

Use the enter key to type the text in the next line. 

Once you have entered text you can make 

changes to it anytime. To make changes to the 

text, click on the text area or the text box and 

select the text where changes are to be made and 

make the necessary changes such as cut, copy, 
 

paste, format and align using the editing and formatting tabs available in Home tab on the 
ribbon.  
 
 

To add a new slide, click on the Home tab, click on the 

New Slide tab in the slides group. If you want to add a 

new slide with a different layout, click on the drop down 

menu of the New Slide option. Various office themes are 

listed; you can choose any layout as per your 

requirement. 

 

You can also delete a slide from your presentation. To 
 

delete a slide, select a slide to be deleted and click in the slides group of the Home tab. You 
can also press the delete key to delete a particular slide. 

 

Preparation of Slides 
 

In a presentation, you may be required to insert pictures, clipart images, tables and other 

objects. PowerPoint offers you to insert these in your presentation to make it more 

interesting to the viewers. 

 

How to insert a Picture? 
 

1. Select the slide in which you want to insert a 
picture  

2. Click on the Insert tab 
 

3. Click Picture in the illustrations group. An Insert 
picture dialogue box will appear  



 

4. Browse through the folder that contains the pictures to 
be inserted 

 
5. Select the picture and click the Insert drop down menu. 

The selected picture gets inserted into the slide. 

 

How add or insert Clipart picture?   

1. Select the slide in which the clip art needs to be added  
2. Click on the insert tab in the illustrations group 

 
3. The clip art search dialogue box appears. Type a key word 

in the search for text box  
4. Click on the go button next to the search for text box 

 
5. Select a clip art in the clip art results. Click on the picture 

and the selected clip art picture is inserted into the slide.  
 
 
 
 

 

How to insert a table in the presentation? 
 

1. Select the slide in which you want to insert the table  
2. Click on the Insert tab  
3. Click the Table drop down menu  
4. Select the Insert Table option 

 
5. Select the Number of columns and rows. Click OK to insert the table. 

Add text to the table as desired  
6. Click on any blank area outside the table area to deselect the table  

 
 

 

Other objects such as bitmap images, graphs or charts and any other documents such as word 

documents and excel worksheets can also be inserted in the slides of the presentation. 

 

How to insert an object?   

1. Select the slide in which the object needs to be 
inserted  

2. Click on the Insert tab  
3. Click the Object option  
4. The Insert Object dialogue box appears 

 
5. Select the ‘Create New’ option. This helps you to 

insert a new object such as a new or existing 

worksheet or word file into the slide  
6. Click OK.  



 

When you create a new worksheet, it is embedded as an object in your slide. All of the excel 

options and controls are displayed in the ribbon. You can use these options to enter or edit 

data directly in the new worksheet. 
 
 

When you insert an object, be it a picture, 

object, table or clipart, you need to resize and 

scale it to the best fit in the slide. When you 

click on the object, the resize handles appear at 

the corner of the object. These handles enable 

to resize the objects in two dimensions. When 

you click on any of the resize handles you can 

change the height and width of the object by 
  

dragging the handles. You can also scale an object, that is resize the object according to the 

percentage. You can also use the format or design option to modify the size and style of the 

object. 
 
 

EXERCISE 3 

 

Which of the following tabs helps insert a new slide in a presentation? 

a. Home 
b. Insert 
c. Slide Show 
d. Design 

 

 

5.2 PRESENTATION OF SLIDES 

 

Viewing a PowerPoint Presentation 
 

The following are the various ways of viewing a PowerPoint presentation:  
 
 

 Normal View: It is the default way of viewing PowerPoint 

presentation. Normal view is the main editing view, where you can 

write and design your presentations.



 Slide Sorter: Slide Sorter view provides you with a view of your 

slides in thumbnail form. This view makes it easy for you to sort 

and organize the sequence of your slides as you create your 

presentation, and then also as you prepare your presentation for 

printing.



 Notes Page: The Notes pane is located just below the Slide 

pane. You can type notes that apply to the current slide. 

Later, you can print your notes and refer them when you give
 



 

your presentation. You can also print notes to hand out to your audience or include 
the notes in a presentation that you send to the audience or post on a Web page.  

 
 

 Slide Show: Slide Show view takes up the full computer screen, like 

an actual presentation. In this view, you see your presentation the 

way your audience will. You can see how your graphics, timings, 

movies, animated effects and transition effects will look during the 

actual presentation.

 

Presentation Setup and Printing 
 

You can display a presentation as an On-screen slide show as 35 mm slide, as overheads or 
as printout you can also specify other set up properties such as page set up for notes. 

 

A slide consists of a documentation area that is normally divided into title and subtitle bar. 
 

Both these parts contain place holders, a faint dotted line appears around each place holder. 

 

How to specify presentation set up?   

1. Click on the Design tab 
 

2. Click the Page Setup option in the Page Setup 
group 

 
3. Select an appropriate size for the slide size 

from the drop box 
 

4. Select the orientation of the slides, notes, handouts & 
outlines from the orientation section  

5. Click OK to apply the set up 
 

6. After setting up your presentation you can print your 
slide or handouts.  

 

How to print a presentation?   

1. Click on the Office button  
2. Point the mouse to the Print option  
3. Select the Print option  
4. The Print dialogue box appears 

 
5. Select a printer from the Name drop down menu in the 

printer section 
 

6. A printer’s dialogue box appears. Select the print range 

from the print range section. You can print the entire 

presentation in one go or print the slides that you need. 
 

You can also print specific slides by selecting the slides 

radio button and by entering the slide number in the text 

box next to it. Select an appropriate option from the Print 
 



 

what drop down menu. It allows you to select slides, handouts, notes, pages or 
outline view to print 

 

7.  Click OK to print the desired part of the presentation.  

 

EXERCISE 4 

 

In which of the following view PowerPoint window is not visible? 

a. Normal 
b. Slide Show 
c. Slide Sorter 
d. Notes Page 

 

 

Animations and Slide Show 
 

Animations enhance your presentations visually. You can provide animation to your texts 

and visuals in the slide. You can also provide transitions to the slides. It helps you to select 

how the texts and visuals in the slide will appear in the presentation. It also helps in 

selecting the appearance and transition of the slides in the presentation. 

 

How to set animation to the slides? 
 

1. To set the animation to the text or visuals, you need to 
set the presentation in normal view.  

2. Select the text or the visual that you want to animate  
3. Click on the animations tab 

 
4. Click on the animate drop down menu in the animations 

group  
5. Select an animation from the list.  

 
 

The animation is set for the selected text or visual. PowerPoint provides quick preview of 

the animated slide. To see the preview again click on the preview option in the animations 

tab. 

 

How to set transition to the slides? 
 

1. Select the slide  
2. Click on the animations tab 

 
3. Select a transition from the transitions to this slide 

group 
 

4. Click on the transition sound drop down and select a 

sound from the list to provide sound effect to the 

transition of the slide 
 

5. Click on the transition speed drop down menu and 
select the slide transition speed as slow, medium or fast  



 

6. Check an option in the advance slide to set how the presentation moves to the next 

slide. You can set certain number of seconds after which the presentation moves to 

the next slide  
7. Save the presentation to apply the changes 

 
 

Once you have created a presentation and defined the animation and transition to it, you 
are ready to show it. Use slide show to display your presentation to the viewers. 

 

How to set up a Slide Show?   

1. Click on the slide show tab 
 

2. Click on the set up slide show option in the set 
options  

3. The set up show dialogue box appears  
4. Click on one of the options in the show type options  
5. Select either presented by a speaker (full screen) or browsed at a kiosk (full screen) 

 

How to Automate a Slide Show?   

1. Click on the slide show tab 
 

2. Select the rehearse timing option in the set up 
group 

 
3. The slide show begins with a rehearsal dialogue box 

 
4. Click on the next arrow button when you are ready to 

move to the next slide. You can also navigate to the next 

slide using the arrow key on the keyboard  
5. Repeat step 3 until all the slides are shown  

 
 
 
 

 

If you want to run the slide show from a particular 

slide, click on, the from current slide option in the 

start slide show group in the slide show tab. To slide 

show either use the button at the right hand key on 

the presentation window or press f5 key. The slide 

show starts from the first slide. 
 
 
 

 

EXERCISE 5 

 

Which of the following tab allows you to set transition speed to the slides? 

a. Design 
b. Animations 
c. Slide Show  
d. Insert 



6. INTRODUCTION TO THE INTERNET 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

LEARNING OUTCOMES 

By the end of this module, you should be able to: 
 Learn about Internet, its applications and connections
 Identify the types of Internet resources and use search engines

 

LESSON PLAN  

6.1 Introduction to Internet 

6.2 Internet Resources 



 

6.1 INTRODUCTION TO INTERNET 

 

 

The Internet is a global network of computer networks that connects millions of computers 

worldwide. The Internet allows people to communicate and exchange information or data 

with people all around the world. Through internet, you can send any information or 

messages to any part of the world within seconds. The internet also helps you to get latest 

information on any subject like railway reservation, weather, current affairs, etc. You can 

also use internet to buy and sell products, pay bills, and perform transactions with your 

bank accounts. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Connecting to the Internet 
 

To access Internet, there are 3 basic elements you need in your computer: Modem, Internet 
Service Provider and Browser.  
 
 

a) Modem: It is the device that allows computers to transmit 

and receive data. This is the device which connects a 

computer to the Internet. 
 
 
 
 

b) Internet Service Provider (ISP): The ISP is a company that 
provides access to the Internet. 

 
 
 
 
 
 
 

c) Browser: It is the software which retrieves, presents and 
navigates information on the internet. Some popular  

http://simple.wikipedia.org/wiki/Computers
http://en.wikipedia.org/wiki/Internet


browsers are Internet Explorer (IE), Mozilla Firefox, Google Chrome and Safari. 
 

You can connect to the Internet using cables and wireless technology. A computer that 

supports wireless technology has a wireless fidelity or a Wi Fi card. The Wi Fi card enables 

wireless communication between the computer and the network. 

 

Four Types of Internet Connections  
 
 

a) Dial up Connection: Dial-up connection uses the 

telephone line to connect to the Internet. The 

computer uses the modem (often already on the 

computer) and connects the home phone line to it. A 
 

call will be made to the Internet service provider's modem and the link will be 

made to enable the access to the Internet. This was the first way to connect to 

the Internet. 
 
 

b) Integrated Services Digital Network (ISDN): ISDN is similar 

to dial up but offers connectivity through digital phone 

lines. It allows the usage of phone and internet at the same 

time. Much faster than dial-up and also more stable. You 

need an external modem to use this network. ISDN enables 

wide-bandwidth digital transmission over the public 

telephone network, which means more data can be sent at 

one time. A typical ISDN connection can support transfer 

rates of 64K or 128K of data per second. 
 
 

c) Direct Internet Access: Direct-connections 

do not require dialling and logging-on to 

the Internet or any other network. 

Dedicated access line services may not be 

offered by one, distinct end-to-end cable. 

Services do offer guarantees of stable 

bandwidth availability and near constant 

latency, which are the attributes, not 
 

guaranteed on more public platforms. These attributes add significant value to 
the price. 

 
 

d) Digital Subscriber Line (DSL): DSL or 

Broadband is a high-speed Internet service 

like cable Internet. DSL provides high-speed 

networking over ordinary phone lines using 

broadband modem technology. DSL  

http://www.businessdictionary.com/definition/internet.html
http://compnetworking.about.com/od/broadband/g/bldefcablemodem.htm


 

technology allows Internet and telephone service to work over the same phone 

line without requiring customers to disconnect either their voice or Internet 

connections. DSL technology theoretically supports data rates of 8.448 Mbps, 

although typical rates are 1.544 Mbps or lower. DSL Internet services are used 

primarily in homes and small businesses. DSL Internet service only works over a 

limited physical distance and remains unavailable in many areas where the local 

telephone infrastructure does not support DSL technology. 
 
 

EXERCISE 1 

 

1) Using Internet we can: 
a) Send a letter to our family and friends 
b) Book a railway ticket 
c) Check our bank account 
d) Pay electricity bills 

 
2) Which of the following are needed to access Internet? 

a) Computer 
b) Modem 
c) ISP 
d) Browser 

 
 

 

6.2 INTERNET RESOURCES 

 

World Wide Web (WWW) 

 

WWW stands for ‘World Wide Web’. It is important to know that this is not a synonym for 

the Internet. The World Wide Web or ‘the Web’ is a subset of the Internet. The Web 

consists of pages that can be accessed using a Web browser. The Internet is an actual 

network of networks where all the information resides. 

 

Telnet, FTP, Internet gaming, Internet Relay Chat (IRC) and E-mail are all part of the Internet, 

but are not part of the World Wide Web. The Hyper-Text Transfer Protocol (HTTP) is the 

method used to transfer Web pages to your computer. With hypertext, a word or phrase 

can contain a link to another Web site. 

 

Components of World Wide Web  
 
 

a) Web Server: A Web server is a system that 

delivers content or services to end users 

over the Internet. Web servers are 

computers that deliver (serves up) Web 

pages. Every Web server has an IP address 

http://compnetworking.about.com/library/glossary/bldef-kbps.htm
http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/W/web_page.html
http://www.webopedia.com/TERM/W/web_page.html
http://www.webopedia.com/TERM/I/IP_address.html


 

and possibly a domain name. For example, if you enter the URL 

http://www.google.com/index.html in your browser, this sends a request to the Web 

server whose domain name is google.com. The server then fetches the page named 

index.html and sends it to your browser. 
 
 
b) Web Browser: A web browser is a software 

application used to locate, retrieve and 

display content on the World Wide Web, 

including web, images, video and other files. 

As a client/server model, the browser is the 

client run on a computer that contacts the 

Web server and requests information. The 

Web server sends the information back to 

the Web browser which displays the results 

on the computer or other Internet-enabled 

device that supports a browser. 
 
 
c) Web Page: Web pages are what make up the 

World Wide Web. These documents are written 

in HTML (hypertext mark-up language) and are 

translated by your Web browser. Web pages 

can either be static or dynamic. Static pages 

show the same content each time they are 

viewed. Dynamic pages have content that can 

change each time they are accessed. These 

pages are typically written in scripting 

languages such as PHP, Perl, ASP, or JSP. Please 
 

note that a Web page is not the same thing as a Web site. A Web site is a collection of 
pages. A Web page is an individual HTML document. 

 
 
d) Web Site: It is a connected group of pages on the 

World Wide Web regarded as a single entity, usually 

maintained by one person or organization and 

devoted to a single topic or several closely related 

topics. The first web page that is displayed when you 

access the web site is known as home page. Every 

web site has a unique home page. 
 
 
e) Web Address: An address string containing the access 

protocol, domain name, and file or resource path which 

is normally used to specify the address of a  

http://www.webopedia.com/TERM/D/domain_name.html
http://www.webopedia.com/TERM/U/URL.html
http://www.webopedia.com/TERM/B/browser.html
http://www.webopedia.com/TERM/A/application.html
http://www.webopedia.com/TERM/A/application.html
http://www.webopedia.com/TERM/W/World_Wide_Web.html
http://www.webopedia.com/TERM/W/web_page.html
http://www.webopedia.com/TERM/C/client_server_architecture.html
http://www.webopedia.com/TERM/C/client.html
http://www.webopedia.com/TERM/S/server.html
http://www.webopedia.com/TERM/W/Web_server.html
http://dictionary.reference.com/browse/organization


 

web page, image, or other document on the Internet. A URL is written as 

http://www.chetna.com. In this URL, http:// indicates the protocol to be used to access 

the web page; www indicates the web site is on World Wide Web; chetna indicates the 

name of the web site and .com (dot com) indicates the name of domain. The domain 

name suffix indicates the type of organization to which the Web Site belongs. 

 

Internet Explorer  

 

Opening an Internet Explorer Browser 
 

1. Click the Start button  
2. Go to All Programs and click on Internet Explorer  
3. The Internet Explorer window appears 

 
 
 
 

 

The Internet Explorer window is divided into the following: 
 

 

 Title Bar: This displays the name of Web Page and Web Browser. It contains three 
window buttons – Minimize, Restore Down or Maximize and Close.


 Address Bar: The name of the website or URL that you wish to browse is typed in the 

Address Bar. It contains Go or Refresh and Stop buttons. The Go button helps you 

load a webpage or website, the Refresh button helps you to reload the webpage and 

the Stop button stops any current operations by the explorer. On the left side of the 

Address Bar, there are Back and Forward buttons. These buttons help navigate to the 

previous and the next website that was visited recently.


 Menu Bar: This contains many menu options like File, Edit, View, Favourites, Tools 
and Help.

 Web Page Area: This is the area where the website or webpage is displayed.


 Status Bar: It provides the progress or status of a website/webpage as waiting, 
loading or done. 

 

EXERCISE 2 

 

Which of the following is composed of one or more web pages linked 
together?  

a) Web Server 
b) Web Site 
c) Web Browser  
d) Web Address 

http://www.chetna.com/


Search Engines 
 

A Search Engine (SE) are websites whose purpose is to find 

websites that contain the information that a user is looking for but 

does not know the specific address of that website. Some 

commonly used SEs are Google, Yahoo, MSN, etc. Google is the 

most popular SE. They search documents for specified keywords 

and return a list of the documents where the keywords were found. 
 

 

The SEs use electronic devices called Robots or Spiders. They run around the internet, 

including the WWW to search for the requested information. Different SEs use different 

methods of searching and they search for different sections of the webpages as per some 

keywords like Web page’s titles, URL and entire text of the webpage. 

 

Types of Search Engines: 
 

a) Multi/Meta SE: They employ more than one individual SEs to find your keywords. 
Google, Bing and Mamma are examples of this SE. 

 
b) Directory: They use a directory of websites that are manually examined and 

categorized as per the information they contain. Yahoo is an example of a Directory 

SE. 

 

Using a Search Engine 
 

When you use SEs to find something on the Internet, you are basically asking the SE to scan 

its database and match your keywords and phrases with the content of the URLs they have 

on file at that time. Spiders regularly return to the URLs they index to look for changes. 

When changes occur, the index is updated to reflect the new information. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

EXERCISE 3 

 

Which of the following is a Directory search engine?  
a) Mamma  
b) Google  
c) Yahoo  
d) Bing 

http://www.webopedia.com/TERM/K/keyword.html


7. COMMUNICATION TOOLS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

LEARNING OUTCOMES 

By the end of this module, you should be able to:  

 Identify Communication Tools

 Create and use an Email account

 

LESSON PLAN 

7.1 Communication Tools 



7.1 Communication Tools 

 

Introduction to E-mail 
 

Email or electronic mail is the method of exchanging 
messages on the internet. An email contains various sections   

– Recipients field, Subject field and Message area. You need 

to have an email account to use this application. Many web 

based free e-mail services are available like Gmail, Yahoo and 

Hotmail. You can create your own email account in any or all 

of these websites. 
 
 

EXERCISE 1 

 

Which of the following website does provide the Web based free email 
service? 

a) Skype 
b) Facebook 
c) Blogger 
d) Hotmail 

 
 

 

Creating an E-mail account 

 

Step 1: Open the Internet Explorer.  

 

Step 2: Type www.gmail.com in address bar. 
 
 
 
 

 

Step 3: Click on the Go button or press enter.  
 
 
 
 
 

 

Step 4: Click on the CREATE AN ACCOUNT button.  
 
 
 
 
 
 
 

 

Step 5: Fill the online registration form. 

http://www.gmail.com/


 

Step 6: Click on the Next Steps button.  
 
 
 
 
 
 
 
 
 

 

Step 7: Click on the Continue to Gmail button. 
 
 
 
 
 
 
 

 

Using an E-Mail account   

1. To access your email account, you first need to sign in. For 

this, first go to the Gmail homepage and type your Username 

and Password displayed on the right side of the screen. Then 

click on Sign In at the bottom. 
 
 
 
 
 
 
 
2. You can now view your accounts page. Various links are 
displayed on the page like - Inbox, Starred, Important, Sent 
 
Mail, Drafts, Compose, etc. These contain related email items. 

You can also chat with your friends who are online. Inbox 
contains all your incoming mails. By clicking on Inbox you can 
access all emails that you have received. 
 
 
 
 
 
3. On the right section, you can see all the emails that you 

have received and by clicking on them you can open each of 

them to view it. If you want to Reply to the sender of an email, 

you just need to click on the arrow displayed on the right side 

of the email and then click on the Reply button. A Reply box is 

displayed with the recipient’s email id filled in the ‘To’ field.  
Type your reply in the message text area and then click on the  
‘Send’ button on the top to send your email.  



Writing a new Email 

 

Step 1: Click on the Compose button and a new message window is displayed. 
 

 

Step 2: Type the email id of the person whom you want to send the email in the ‘To’ field. 

You can send the email to multiple persons by adding their email ids in the ‘To’ field using a 

comma (,). 
 
 
 

Step 3: In the ‘Subject’ field, type the subject of your 
message. 

 

Step 4: Type your message in the message area. 
 

You can also attach documents, pictures, etc. with the 

message by clicking on ‘Attach a file’ link just below the 

‘Subject’ box. The formatting buttons just on top of the 

message area allows you to format your message 

according to your need. 
 
 

Step 5: Once you finish typing your message, click on the ‘Send’ button to send your 
message. 
 

 

All the successfully sent emails are stored in the Sent Mail folder. Some of your incomplete 
emails are stored in the Drafts folder. You can complete these drafts any time and send it. 

 

Details of Key Links of Email 
 

 Reply: Select this option to send an email to the one that you have received it from.


 Reply All: Select this option to send an email to all the email ids mentioned in the 
email that you received.


 Forward: If you want to send a particular email to a person whose email id has not 

been added in any of the fields, then you can forward the email to him/her by using 

the ‘Forward’ button. You just need to type the email id of that person and click on 

‘Send’.


 Attachment: Attachments are files that are sent along with email messages like 
reports, documents, photos, etc. 

 

 

EXERCISE 2 

 

Which of the following is required to access a mail account? 

a) Only username 
b) Only password 
c) Username and Password 
d) Sender’s Email ID 



8. COMMUNICATION AND COLLABORATION 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

LEARNING OUTCOMES 

By the end of this module, you should be able to: 

 Use Skype for voice and video chat
 Use Facebook for social interaction and communication
 Play and upload videos using YouTube

 

LESSON PLAN 

8.1 Communication and Collaboration 



 

8.1 COMMUNICATION AND COLLABORATION 

 

USING SKYPE FOR VOICE AND VIDEO CHAT 

 

Skype is a communication tool which allows you to talk through internet to anyone in any 

part of the world for free. You can make a call from your computer/laptop to other Skype 

users for free and to landlines or mobile phones for a fee. Skype has features like instant 

messaging, file transfer, voice calls and video calls. 

 

Steps in Downloading and Installing Skype 

 

Step 1: Click on start button and then click Internet Explorer. 

 

Step 2: Once Internet Explorer is opened, type www.skype.com in the address bar 

 

Step 3: Click on the Go button or press Enter  
 
 

Step 4: The Skype homepage is now open. Click on download link, 
computer is selected by default in device section.  
 
 
 
 
 
 
 
 
 
 
 
 

 

Step 5: Click on Get Skype for Windows desktop button.  
 
 
 
 
 
 
 
 
 
 
 
 

Step 6: The opening SkypeSetup.exe appears, click on 

Save button and save the file in an appropriate location 

on your computer. 

http://www.skype.com/


 
 

 

Step 7: To install the application, go to the location where setup file is saved and then 
double click on the SkypeSetup.exe file. Open File- Security Warning appears.  
 
 

 

Step 8: Click on Run button to start the installation.  
 
 
 
 
 
 
 
 
 
 

 

Step 9: Select English in language dropdown 
menu and then click I agree – Next button.  
 
 
 
 
 
 
 
 
 
 
 
 

 

Step 10: Click on Continue button. The Skype 

installation starts. Wait for the installation to 

complete. 
 
 
 
 
 
 
 
 
 
 

 

Step 11: Once installation is complete, click on 

Create an account button. A sign-up web page 

appears. 



 
 

 

Step 12: Fill the registration form with the required 
details.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Step 13: Enter the security words displayed in the box 

and then click on I agree- Continue button. Your Skype 

account is created. 
 
 
 
 
 
 
 

 

Using Skype: Interacting with Contacts  
 
 

Step 1: Start Skype, enter your Skype Name and 
Password and then click on Sign me in button. 
 

(When you sign in for the 1
st

 time, you need to check 

your microphone and camera. You can also upload a 
profile picture for your Skype ID).  
 
 
 
 
 
 
 

Step 2: Now you need to add contacts on Skype. Click 

on the Contacts menu option, select Add Contact and 

then select Search Skype Directory. 



 

Step 3: Provide the details of the person you wish to add. It asks for 

email, phone no, name and skype name details. Search the contact 

and click Add button to add the contact. 
 
 

Step 4: A contact request box is displayed. Click Send request button. 

When the person accepts your request, his/her name will appear on 

your contact list. 
 
 
 
 
 
 
 
 

Step 5: You can interact with your contacts by selecting 

the contact that is online. The green check mark 

appears beside the contact name showing that the 

contact is online. 
 

 

1. Click on Contacts tab, click on the name of the 

person with whom you want to have a chat 

conversation with. A chat window with the 

person’s name appears. Place your cursor in the 

chat box and start typing your messages. 

 
2. Click send or press Enter to send the message. 
 
 
 
 
 
3. For voice call click on Call button. If contact 
accepts your call then you can talk to him/her.  
 
 
 
 
 
 
 

 

4. To end the call click on end call button. 



 
5. If there is web camera installed on your computer then you can make a video call as well. 

 

6. Click on Video call button to start the video call. 
 
 
 
7. You can also share files to the contacts by selecting the   

contact.  
 
 
 
 
 
 

 

8. Select Conversation button, select Send and then File 
button.  
 
 
 
 
 
 
 
 
 

 

9. Browse and select the file you want to send and then 
click Open.  
 
 
 
 
 
 
 
 
 
 
 

 

10. Your contact can also send you any file and it will 

come in the notification window in contact list as 

orange check marks. 
 
 
 
 
 
 
 
11. You can receive the file by clicking the Save as button. 

Then choose the location where you want to save the file 

and then click on the Save button. 
 
 
12. Chose the location you want to save and then click on 
Save button, which appears in dialogue box.  



 
 
 
 
 

13. To open file, click Open file or click Show in folder.  
 
 
 
 
 
 
 

Step 6: Once you are done using Skype, click Skype and select 

Sign Out button. You are now signed out of your Skype 

account. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

EXERCISE 1 

 

Which of the following menu helps you add a contact to your Skype contact list? 

a) Skype 
b) Contacts 
c) Conversation 
d) View 

 
 

 

Social Media Tools 
 

Social media refers to the means of interactions among 

people in which they create, share, and/or exchange 

information and ideas in virtual communities and networks. 

Social media is the collections of online communications 

channels dedicated to community-based input, interaction, 

content-sharing and collaboration. Websites and 

applications dedicated to Online Chatting, Voice over 

Internet Protocol (VoIP), Blogs and Social 
  

Networking are among the drivers of social media tools. Examples of social media 
applications are - Facebook, Blogs, Twitter, Orkut, Linkedin and Wikipedia. 



Types of Social Media Tools 
 
 

1. Online Chatting: Online chat may refer to any kind of 

communication over the Internet that offers a real-time 

transmission of text messages from sender to receiver. 

Chat messages are generally short in order to enable 

other participants to respond quickly. Thereby, a feeling 

similar to a spoken conversation is created, which 

distinguishes chatting from other text-based online 
 

communication forms such as Internet forums and email. Online chat may address 

point-to-point communications as well as multicast communications from one 

sender to many receivers and voice and video chat, or may be a feature of a web 

conferencing service. Few examples are Yahoo Messenger and G-talk. 
 
 

2. Voice over Internet Protocol (VoIP): VoIP is a technology 

used for Internet phone services. Through VoIP calls can be 

made on the Internet using a VoIP service provider and 

standard computer audio systems. VoIP offers a substantial 

cost saving over traditional long distance telephone calls. 

The prime example of VoIP is Skype. 
 
 

3. Blogs: Blog is an online journal kept by an individual, group 

or organization. Blogs can be used for sharing information 

about your subject on the internet, share news about 

recent events or developments, and share interesting 

discussions and debates by writing about them. Examples of 

Blogs are Blogger and WordPress. 
 
 

4. Social Networking: This is a platform to build social 

networks or social relations among people who, share 

interests, activities, backgrounds or real-life connections. 

Social networking is web-based services that allow 

individuals to create a public profile, to create a list of users 

with whom to share connection, and view and cross the 

connections within the system. Facebook, Twitter, Linkedin, 

etc. are some examples of Social Networking sites. 

 

5. Wiki: Its a web application which allows anyone to add, 

edit or modify content that has been placed on the 

website. The best known example of a wiki website is 

Wikipedia.  

http://en.wikipedia.org/wiki/Communication
http://en.wikipedia.org/wiki/Internet
http://en.wikipedia.org/wiki/Real-time_text
http://en.wikipedia.org/wiki/Text-based
http://en.wikipedia.org/wiki/Internet_forum
http://en.wikipedia.org/wiki/Email
http://en.wikipedia.org/wiki/Point-to-point_%28telecommunications%29
http://en.wikipedia.org/wiki/Multicast
http://en.wikipedia.org/wiki/Videotelephony
http://en.wikipedia.org/wiki/Web_conferencing
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http://whatis.techtarget.com/definition/Wikipedia


USING FACEBOOK FOR SOCIAL INTERACTION AND COMMUNICATION 

 

Prerequisite requirements in using Facebook - You need to have a valid e-mail account  

 

Steps to use Facebook 
 

Step 1: Open Internet Explorer 
 
 

Step 2: Type www.facebook.com in address bar and then 
click Go button or press Enter   

Step 3: In the Sign up, fill in the registration details in the 

boxes and then click on the Sign Up button. It will take 

you to three steps process to complete the registration. 
 
 
 
 
 
 
 
 
 

 

Step 4: Click on find friends button to add contacts, you can skip this process at this stage.  
 
 

 

Step 5: Fill out profile information page; you can skip this 
process as well.  
 
 
 
 
 
 
 

Step 6: You can set your profile picture by uploading a 
photograph present in your computer. 
 

 

Step 7: Click save and continue button and your Facebook 
account is created.  
 
 
 
 

 

Step 8: You can add people by typing their name or e-mail 
in Find people you know section. 

http://www.facebook.com/


 
 

 

Step 9: You can upload your status as well on Facebook, to 

do that click on status button and then type your status 

and then click Post button. 
 
 
 
 

 

Profile page provides various tabs 
 

- In Timeline tab you can specify about your workplace, city, school and your 
relationship status. 

 
- You can comment on the posts of your friend. For that you need to click on comment 

link and then comment box appears, type your comments and press ENTER.  
 
 

 

Facebook bar tells you about Friend request, 
messages and recent activities by your friends. 
 
 

The bar also contains search box where you can 

search your friends by typing his name and then 

you can visit his profile 
 
 
 
 
 
 
 
 

 

Click on Add friend button to send the friend 
request to him/her. 
 

Once you are done with Facebook, you can sign 

out by clicking setting icon on Facebook bar and 

then click on log out option. 
 
 

 

Now you have a Facebook account, when you 

visit next time, sign in using your e-mail or 

phone number and then type your password. 

Click on the Log in button to login to your 

account and stay connected with your friends 

and family. 
 



PLAY AND UPLOAD VIDEOS USING YOUTUBE 

 

YouTube is the free website offered by Google. It is video sharing platform, founded in 

February 2005. YouTube allows billions of people to discover, watch and share originally-

created videos. YouTube provides a forum for people to connect, inform, and inspire others 

across the globe and acts as a distribution platform for original content creators and 

advertisers large and small. 

 

Steps to run YouTube 

 

To run YouTube, one needs to have internet connectivity, adobe flash player and a speaker. 

 

Step 1: Click on start button and open Internet Explorer. 

 

Step 2: Type www.youtube.com in address bar and click on Go button or press Enter.  
 
 

Step 3: The YouTube webpage loads. You can see the search bar 
on top of the page. 
 

 

Step 4: Type search items or search keywords and click on the 

Search button or press Enter. A list of video links against the 

search items appears on the screen. 
 
 
 
 
 
 
 
 

 

Step 5: Click on the link to watch the related video. 
 
 

Step 6: The selected video is played in the video player. You can 

see various controllers below the video player like play/pause, 

volume/mute, total time, change quality and full screen. 
 
 
 
 
 

 

You can find details and comments on the video below the video. 

You do not need an account to view popular and general videos 

on YouTube, but you need a login account to view private videos. 

To login to your account 

http://www.youtube.com/


Uploading Videos on YouTube  
 
 

Step 1: To sign in to YouTube using your Google 

account, click on the Sign In button on top right hand 

corner of the YouTube webpage. The Google Sign In 

page appears. 
 
 

Step 2: Enter your Email and Password and click on Sign In button. If you do not have Google 
account then you need to create it.  
 
 
 
 

 

Step 3: The YouTube page will appear. Click on Upload 
button next to Search Box.  
 
 
 
 
 
 
 

Step 4: For first time users, it will ask you to set up 

your channel and give some personal details like 

gender and date of birth. Fill in those details and click 

on the Continue to upload button. 
 
 
 
 
 
 

Step 5: Click on Select files to upload link.  
 
 
 
 
 
 
 
 
 
 
 
 

Step 6: Browse through your computer and select the 
video you want to upload. Click on Open button. 



 

The downloading starts and the progress is displayed on 
the web page.  
 
 
 
 
 
 
 
 
 

 

When uploading gets completed, a message – ‘Upload 

complete’ appears and the link to the video is also 

displayed. You can view the video later in YouTube. You 

can add the title and description and set the privacy 

setting of the video in the displayed page. 
 
 
 
 
 
 
 

 

Once video is uploaded, you can change the privacy 
setting or delete the video using Video Manager.  
 
 
 
 
 

 

Deleting Videos on YouTube 

 

Step 1: Click on Video Manager  
 
 
 
 
 
 
 

 

Step 2: Click on video to be deleted  
 
 
 
 
 
 
 

 

Step 3: Click on Actions menu and select delete. 



 

Step 4: A confirmation message is displayed. Click on ‘Yes, 
delete’ button and your video gets deleted.  
 
 
 
 
 
 
 
 
 
 
 
 

 

EXERCISE 2 

 

Which of the following is an example of blogging application? 

a) Gtalk 
b) WordPress 
c) Skype  
d) YouTube 


